
ANNOUNCEMENTS

Discontinuation of Index to MINITEX/OCLC Mailing

In last month’s MINITEX/OCLC Mailing, we asked whether you used the cumulated index we have
produced on an annual basis.  We received only two responses, both indicating that the users do not
keep back issues of the Mailing and thus do not need the index.  Thus, we have decided to
discontinue compilation of the index.

We would like to take the opportunity to remind you that, should you ever need to refer to a back
issue of the Mailing, they are posted on the MINITEX website at:

http://www.minitex.umn.edu/oclc/monthly.asp

GENERAL

Updates to OCLC Training Materials

An upgrade to a new version of Searching WorldCat: An OCLC Tutorial ensures that you are
learning the latest searching techniques.

Version 1.01 of the Searching WorldCat tutorial incorporates updates to searching strategies for
keyword searching and the numeric LCCN and ISSN search keys. Details of these changes can be
found in Technical Bulletin 235 Rev.: Keyword Searching Changes in WorldCat at

http://www.oclc.org/oclc/tb/tb235/frames_man.htm

and Technical Bulletin 241: National Library Control Number Changes at

http://www.oclc.org/oclc/tb/tb241/

Download version 1.01 from the OCLC website at:

http://www.oclc.org/oclc/menu/tutorial.htm

http://www.minitex.umn.edu/oclc/monthly.asp
http://www.oclc.org/oclc/tb/tb235/frames_man.htm
http://www.oclc.org/oclc/tb/tb241/
http://www.oclc.org/oclc/menu/tutorial.htm
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Using Interlibrary Loan: An OCLC Tutorial also may be downloaded from the OCLC website at

http://www.oclc.org/oclc/usingill/index.htm

This tutorial explains the main functions of the OCLC borrowing and lending cycle as well as
general ILL concepts. Other OCLC ILL features, such as how to create custom holdings and
multiple constant data records and how to use Reasons for No and OCLC ILL Direct Request, are
also explained.

Both tutorials will be available on version 4.0 of the OCLC Access Suite CD in early 2001.

[Lynn Ziegler, OCLC, Bits and Pieces, Dec. 2000; edited]

COLLECTIONS AND TECHNICAL SERVICES

MARC Bib Update: Brief and Truncated Record Displays

On Dec. 10, 2000, OCLC installed the third set of changes related to the MARC Bibliographic
Update, 2000. An additional change related to identification of national libraries in Brief and
Truncated record displays was not documented originally in Technical Bulletin 236 or in the Dec.
2000 MINITEX/OCLC Mailing. This information is now included Technical Bulletin 236 part 2,
section 5:

http://www.oclc.org/oclc/tb/tb236

The criteria used to retrieve and display records by the Cataloging Source qualifier, 'dlc', changed.
Non-DLC PCC records are identified separately from DLC records and no longer use data from
field 040 subfield ‡d. Also, other national libraries identified as the cataloging source in Brief and
Truncated record displays that result from searches not qualified by 'dlc' are changed. Only records
with a national library symbol in field 040 subfield ‡a or ‡c will be noted in the description in Brief
record displays and Column L in Truncated record displays. (For a list of the national libraries and
codes, see Searching for Bibliographic Records, section 8.)

 If the library's symbol appears in field 040 ‡d only because it has modified the record, its symbol
or code will not be noted in the Brief and Truncated record displays. Exception: The code
identifying PCC records when the authentication code, 'pcc,' in field 042 is added to a record.

[Ellen R. Caplan, OCLC, Bits and Pieces, Dec. 2000; edited]

http://www.oclc.org/oclc/usingill/index.htm
http://www.oclc.org/oclc/tb/tb236
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 More Code List Additions and Changes for Dec. 2000

The Library of Congress recently announced several additions to the MARC Code Lists for
Relators, Sources, Description Conventions. These codes became available for use by OCLC
members on Dec. 10, 2000. In addition, OCLC invalidated one code for use in field 084 and
validated another in its place.

Description Convention Codes: Field 040 ‡e--Cataloging Source

ncs Norme per il catalogo degli stampati

Source Codes: Field 084 ‡2--Other Call Numbers

cacodoc CODOC [Canadian federal and provincial government documents classification
scheme] (Toronto: Office of Library Coordination, Council of Ontario
Universities)**

rubbkd Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia detskikh bibliotek v 1 t.

rubbkk Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia kraevedcheskikh
katalogov bibliotek

rubbkm Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia massovykh bibliotek v 1
t.

rubbkmv Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia massovykh voennykh
bibliotek

rubbkn Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia nauchnykh bibliotek v 4-
kh tomakh

rubbknp Pereizdaniia tablits bibliotechno-bibliograficheskoi klassifikatsii dlia nauchnykh
bibliotek v 30-ti tomakh

rubbko Tablitsy bibliotechno-bibliograficheskoi klassifikatsii dlia oblastvykh bibliotek v 4-
kh tomakh

Source Codes: Fields 600-651 ‡2--Subject Added Entries

lnmmbr Lietuvos nacionaline Martyno Mazvydo bibliotekos rubrikynas

cncodoc Canadian federal and provincial government documents classification scheme
(Ottawa: Canadian Task Force on Cataloging Standards)**
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! ‘cncodoc’ was changed to ‘cacodoc’ in 1998. It was removed from the Validation Rules and all
records with this code have been corrected. ‘cacodoc’ should be used instead.

[Ellen R. Caplan, OCLC, Bits and Pieces, Dec. 2000; edited]

 OCLC-MARC Code Lists Discontinued Dec. 2000

In response to a member survey, OCLC has discontinued publication of OCLC-MARC Code Lists
in print and on the OCLC website. OCLC will notify each library by letter that holds OCLC-MARC
Code Lists about this change.

Reasons for discontinuance

•  USMARC Code Lists are available from the Library of Congress in print and on its website at
http://www.loc.gov/marc/marc.html.You can also print these lists as needed.

•  The OCLC system uses the codes prescribed by the Library of Congress. OCLC-MARC Code
Lists replicates much of the USMARC Code Lists with little OCLC customization of
information.

•  OCLC has never supplied the information contained in USMARC Code List for
Organizations.

•  US depository libraries currently receive the printed copies of LC's USMARC Code Lists.

 OCLC will support

•  Continue to answer questions about existing codes and about entities for which codes do not
yet exist.

•  Continue to notify you via the MINITEX/OCLC Mailing, Technical Bulletins, and OCLC
Systems News about changes in the codes.

•  Establish links from the OCLC website to the Library of Congress website so you can find
the lists easily:

http://www.oclc.org/oclc/man/code/codetoc.htm
•  Establish a notification list on the OCLC website to relay code changes as announced by

Library of Congress.

 Need printed copies?

•  If yours is a depository library, consider moving the depository copies of USMARC Code
Lists to the technical services area.

•  The USMARC Code Lists in printed form are available for purchase from LC at
http://lcweb.loc.gov/cds/marcdoc.html#cl This website gives price and ordering information.

[Lois Yoakam, OCLC, Bits and Pieces, Dec. 2000; edited]

http://www.loc.gov/marc/marc.html
http://www.oclc.org/oclc/man/code/codetoc.htm
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CJK Accession List Monthly Production: Technical Hints

OCLC CJK users using printed cards as a "Monthly List of New Books" may want to print the CJK
Accession List on a monthly basis. Here is a quick start to do so:

1) Under Tools > Local File Manager, create a file, for example, CJKList2000Nov.dat for the
records to be included in the 2000 November list.

2) Once your newly acquired items have been cataloged and each MARC record has been updated
(by new input or copy-cataloging) in your working (default) local file, copy records (from the
list or individually) to CJKList2000Nov.dat file using the Edit menu.

3) At the end of the month, set the CJKList2000Nov.dat as your default local file. Set "Records
Print" option to Accession List. Make sure to uncheck "Form Feed between Records."

4) Mark all records in CJKList2000Nov.dat print ready (r) to print them in batch mode.
5) Under Batch> Local Processing, click Record Print. You may sort the records in the Accession

List by selecting the processing order.
6) You may create a shared accession list production file in the local networked workstation with

your colleagues as needed.

[Hisako Kotaka, OCLC, Bits and Pieces, Dec. 2000; edited]

OCLC CatME for Windows Version 1.20 Now Available

OCLC CatME for Windows version 1.20 is now available for electronic download. Visit the
CatME home page at

http://www.oclc.org/oclc/menu/catme.htm

for more information and to download the software.

 OCLC CatME for Windows version 1.20 includes the following changes:

•  Changes to correctly display the new four-digit year LCCN which will be used beginning in
Jan 2001. Without this new version of software, new LCCNs will display incorrectly.

•  Changes to the bibliographic fixed field elements that were implemented with the OCLC
MARC Bibliographic Update in 2000. For more information, see Technical Bulletin 236 at
http://www.oclc.org/oclc/tb/tb236.

•  A link to Bibliographic Formats and Standards on the OCLC website, so you can click in a
variable field to display the page from BF&S to learn more about the tag.

•  A new option to automatically back up your local file when you exit the software or change
local files. A new file with the extension "bak" is automatically created in the directory
where your local file is stored. Please note that the default setting for this option is on, so the
file is automatically created for you.

http://www.oclc.org/oclc/menu/catme.htm
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•  On the Edit menu, a new "Reformat" item redisplays your record with the tags listed in the
correct order.

•  A new "Find/Replace" feature on the Edit menu.
•  A new column on the batch transaction report to list the online Save file slot number for

records which are added to the online Save file via batch processing.
•  A new "Copy Control Number" item on the right-click menu so you can copy the control

number of the record to the Windows clipboard.
•  The Start of Message (SOM) character is automatically added to new tags when you add a

new tag by pressing <Enter> at the end of an existing tag.

Several new macro commands have been added to CatME. See CatME Help for more information
on each. Here is a list of the new commands:

•  CloseList
•  CreateLocalFile
•  DeleteRecord
•  FindText
•  GetFirstSelectedItem
•  GetHoldings
•  GetItemType
•  GetNextSelectedItem
•  IsHeldBy
•  IsOCLCFixedFieldOff
•  Logon
•  Logoff
•  QueryRecordStatus
•  Reformat
•  ReplaceText
•  ReplaceTextAll
•  Search
•  SearchList
•  SetOCLCFixedField

OCLC no longer provides a LAN installation option for CatME. The software must be installed on
the local machine. However, you can continue to copy the installation software to your LAN and
run the installation program from the LAN to easily install it on various workstations. You can
continue to store your local files on a LAN.

CatME 1.20 is compatible with settings and local files from previous versions.

[David Whitehair, OCLC, Bits and Pieces, Dec. 2000; edited]
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OCLC CatME 1.20 Pin-Feed Label Problem... and Fix!

OCLC has received reports from users who upgraded to CatME 1.20 and are now having problems
printing labels to pin-feed continuous label stock.  OCLC is working on a "patch" to address this
problem and expects to make it available for download from the OCLC website in January. The
patch will be a single file for users to download and install.

In the meantime, users may wait for the patch, or they may define a custom form for printing
labels.  If needed, MINITEX can help users define a custom form.

This impacts users with Windows 95, 98, and Millennium who print labels to a pin-feed printer.  It
does not impact Windows NT or 2000 users who encountered this problem with the previous
version of CatME,  so they will already have the custom form set up.

It does not impact users who print to laser stock.

To print continuous labels you must set up a custom label form for use with your pin-feed printer.
Unless you specify a custom form, the printer advances the stock incorrectly, inserting a form feed
after each label.

Creating Custom Label Form with Windows 95, Windows 98 & Windows ME

•  Double-click MY COMPUTER and then double-click the PRINTERS folder.
•  In the Printers folder, right-click the pin-feed printer you use to print labels and select

PROPERTIES.
•  In the Properties dialog box, click the PAPER tab if it is not on top.  If you do not have a

Paper tab, you may need to go to the DETAILS tab and click SETUP; then select the Paper
tab.

•  On the Paper tab in the Paper Size area, select CUSTOM.
•  In the USER-DEFINED SIZE box, specify the width and height of each label area for the

label stock you use.  Take measurements from edge to edge of the STOCK; do NOT
measure the text area of the label itself.  Enter the size in hundredths of an inch.

Typical Label Dimensions

Format Width Height
s16 5.0 inches (500 hundreths) 3.0 inches (300 hundreths)
s14 5.0 inches (500 hundreths) 2.0 inches (200 hundreths)
slb 5.0 inches (500 hundreths) 2.0 inches (200 hundreths)
sp1 3.0 inches (300 hundreths) 2.0 inches (200 hundreths)

•  Click the OK button. Then click OK to close the Properties dialog box.
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If you have any questions about the new version of CatME for Windows or you need to create a
custom form for your pin-feed label printer, please call MINITEX Bibliographic and Technical
Services at 800-462-5348 or 612-624-4002.

[David Whitehair, NETLIST-L Electronic Discussion Group, Dec. 20, 2000; edited]

Corrections to CORC Records

The integration of the CORC database and WorldCat last June revealed a number of problems with
the quality of the data. As of Dec. 12, 2000, OCLC has solved most of the problems. Occasionally,
however, others have arisen. This article summarizes the results of the work to date.

Twenty-one separate kinds of errors were reported. Of them, four were not correctable by software.
They were user input errors and usually constituted questionable or perhaps somewhat misleading
information. They must be reported or corrected record-by-record. Some may not be problems to
most users, for example, "too many subject headings."

In all, more than 25,000 corrections have been applied against the records added to WorldCat from
CORC users prior to July 1, 2000. The only remaining one is restoration of field 699 with Dewey
Decimal class numbers. This problem is slated for correction in the near future.

A few situations require some attention when users input new records. These are also not
correctable with software since they require some manual review and decision making.

1) Invalid URLs. While we have no means for correcting them, we have implemented URL
checking and notification so users can verify and correct the ones in which they are interested.

2) Note fields with HTML embedded (example: <IMB SRC=http). The harvester is still
generating some data such as this. Please review records you are creating to determine if there
might be HTML that you do not want to keep. Delete any that is in the notes data.

3) Duplicate records. By far, the most common complaint has been the number of duplicate
records. While we used existing software to remove duplicates when the databases were
synchronized in June, the solution was far from perfect. We recommend that users search the
Resource Catalog carefully immediately before adding a new record.

4) Incorrect information in the language field. When the harvester is unable to determine a
resource's language, it defaults to 'und' (Undetermined). Please check the language and correct
it when creating a record. This is one of the easiest elements to determine but is frequently left
to default to Undetermined. A more precise code improves indexing capabilities in both
WorldCat and the Resource Catalog.
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OCLC has identified improvements to CORC to reduce the incidence of some kinds of errors.
These will be implemented along with the continuing enhancements. However, we also encourage
user to conscientiously review all new input to determine the accuracy, completeness, and
usefulness of the data in their records.

[Rich Greene, OCLC, Bits and Pieces, Dec. 2000; edited]

CORC Authorities

With the implementation of the CORC (Cooperative Online Resource Catalog) System in July
2000, OCLC implemented a new means of authority control. Using technology available only
within the CORC system, the implementation of object-oriented technology has enabled users to
link ("control") headings in resource records to Library of Congress authority records.

Controlling the headings to the appropriate authority record(s), enables headings to be updated
automatically if the heading in the authority record is changed. Coding in the leader of the
incoming authority record identifies it as a changed record (byte 005). If the authority record is
associated with headings in any resource records, heading(s) in the associated resource record(s)
are updated automatically.

Typical types of updates include changes to tags, indicators, text, and subfield coding. In addition
to those types of routine changes, the control features in CORC use coding in the fixed field to
determine if the heading is an authorized heading (008, byte 09). Also, the updating software
validates if the linked heading can be used as a name, subject, or series (008, bytes 14, 15, and 16,
respectively).

If an authority record is merged into another authority record, headings once associated with the
newly deleted authority record are automatically reassociated with the retained authority record. If
an authority record is deleted (and not merged), the heading in the resource record becomes
'uncontrolled'. If the heading once associated with a deleted Library of Congress subject authority
record, the heading is uncontrolled, and the second indicator is changed from zero to four.

If a change is made to any heading in a resource record as a result of the updating processes, the
changed record is then passed from CORC to the OCLC Cataloging service.

 Reports assist quality control staff to monitor the automated updating process.

 How to Invoke 'Control'

Users can initiate the feature either by selecting Control under the Functions box, or Control All
from the Actions drop-down menu.
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Documentation

More information on CORC authorities and how to control headings can be found at:

http://www.oclc.org/oclc/corc/documentation/index.htm

[Becky Dean, OCLC, Bits and Pieces, Dec. 2000; edited]

Error Reporting Options for WorldCat Records

OCLC offers four options that allow you to report duplicate records and errors or changes to
bibliographic and authority records. You may use any or all of these methods depending on your
preference and the types of errors. This reporting information is also available via the OCLC
System News. (Type news and press <F10> at the Home position to retrieve OCLC System News
messages.)

Proof is required for some changes but not others. Changes in the descriptive fields (245-4XX),
additions of ISBN or ISSN, some specific notes that may require additional added entries, the
cessation of serial records, and lack of references from other forms of names in authority records,
etc., are examples of changes requiring proof.

Option 1 is to report records that require proof. Attach photocopies of the pertinent pages from the
item to a paper change request. Blank copies of the master form for bibliographic records are
available in chapter 5, of Bibliographic Formats and Standards. The authorities form is in
appendix F of the OCLC Authorities User Guide. PDF and electronic versions of these forms are
available at

http://www.oclc.org/oclc/menu/docforms/frameset.htm

Options 2, 3, and 4 are used to report errors that do not require proof. Changes in the fixed-field,
subfield coding, tagging, and obvious typos in nondescriptive elements of the record are examples
that do not require proof. Generally, duplicate record reports for bibliographic records do not
require proof. More documentation, however, may be needed for duplicate authority records. For
instance, a book in hand may supply a list of titles by an author. The list may provide "proof" that
two different authority records are the same people with different forms of name. In this case,
including a copy of the title page and the list of titles with a change request would establish that the
records are duplicates.

Option 2: submit bibliographic change requests and duplicate record reports via electronic error
reporting. For Full Cataloging users, use the Error command to send error reports that do not
require proof. Retrieve the bibliographic record that contains the error, type a free-text message
describing the error in field 952. Send the record to OCLC by either typing the command err at the
Home position and press <F11> (Passport users) or selecting "report error" from Action menu

http://www.oclc.org/oclc/corc/documentation/index.htm
http://www.oclc.org/oclc/menu/docforms/frameset.htm
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(OCLC Arabic, OCLC CJK, and OCLC CatME for Windows users). CORC users can submit
errors and duplicates using the forms under the Useful Links menu. Delete the 952 before taking
final action (Produce, Update, Export, Transfer) so that the field will not appear on your tapes and
archival records.

Option 3: submit forms via e-mail for bibliographic records that do not require proof. Electronic
forms are available from

http://www.oclc.org/oclc/menu/docforms/frameset.htm

for reporting changes and duplicate  bibliographic records. Send the forms to: bibchange@oclc.org

Option 4: report duplicates or changes via the Web. You may want to bookmark your Web browser
for these two Web forms: Electronic Bibliographic Change

http://www.oclc.org/oclc/forms/bibchg.htm

and Report and Electronic Duplicate Report.

http://www.oclc.org/oclc/forms/bibdup.htm

 Reminder

Libraries with a full-mode or higher authorization can lock, edit, and replace minimal-level
bibliographic records (encoding levels 2, 5, 7, K, M, except CONSER authenticated records). They
may "close-out," link, edit, and/or correct full-level non-CONSER records with 10 or fewer
holdings. (CONSER records have one of the following codes in field 042: lc, lcd, nlc, nsdp, isds/c,
nst, msc.)

Member libraries may add a number of fields to enrich bibliographic records. The system allows
you to add:

•  Call numbers and subject headings in schemes not already present in a record, field 006
(Fixed-Length Data Elements-Additional Material Characteristics)

•  Field 007 (Physical Description Fixed Field)
•  Field 300 (Physical Description) to CIP records
•  Add or change field 505 (Contents notes)
•  Add or change field 856 (URL)

For further information on:

•  Change requests to bibliographic records, see chapter 5, Quality Assurance, of the OCLC
Bibliographic Formats and Standards http://www.oclc.org/oclc/bib/chap5.htm

•  Change requests to authority records, see the OCLC Authority User Guide
http://www.oclc.org/oclc/man/5411aug/frames_man.htm

http://www.oclc.org/oclc/menu/docforms/frameset.htm
mailto:bibchange@oclc.org
http://www.oclc.org/oclc/forms/bibchg.htm
http://www.oclc.org/oclc/forms/bibdup.htm
http://www.oclc.org/oclc/bib/chap5.htm
http://www.oclc.org/oclc/man/5411aug/frames_man.htm


MINITEX/OCLC Mailing, January 2001
12

•  Enriching bibliographic records, see the OCLC Cataloging Service User Guide,
http://www.oclc.org/oclc/cataloging/guide/index.htm

OCLC appreciates your cooperative efforts to maintain complete and accurate records.

[Brenda Block, OCLC, Bits and Pieces, Dec. 2000; edited]

Library of Congress Subject Headings with the Terms Afro-American and Afro-Americans

In early Dec. 2000, the Library of Congress staff adjusted approximately 600 LC subject headings
with the heading Afro-Americans as well as those that included the adjectival qualifier Afro-
American changing them to African Americans and African American respectively. The
corresponding subject authority records have been added to the OCLC Authority File. Users should
now begin to use the new headings in cataloging.

Approximately, 130,000 existing bibliographic records in WorldCat are affected by the change.
OCLC staff are now correcting these records to update the subject headings to their current forms.
The majority of corrections should be completed by the end of Dec. 2000.

[Robert Bremer, OCLC, Bits and Pieces, Dec. 2000; edited]

Best of MOUG, 7th Edition, Now Available

The Best of MOUG, 7th edition, contains Library of Congress Name Authority File records for
C.P.E. Bach, J.S. Bach, Beethoven, Boccherini, Brahms, Clementi, Handel, Haydn, Mozart,
Schubert, Schumann, Telemann and Vivaldi. There are also lists arranged by thematic number for
Bach, Handel, Mozart, Schubert, Telemann and Vivaldi (F. and RV).

It also contains English cross-references for Bartok, Dvorak, Glazunov, Gliere, Glinka,
Grechaninov, Janacek, Kodaly, Martinu, Mussorgsky, Prokofiev, Rachmaninoff, Rimsky-
Korsakov, Shostakovich, Smetana, Stravinsky and Tchaikovsky. Each list includes uniform titles
and corresponding authority record control numbers and is current to Aug. 1999.

New in this edition are Gliere, Grechaninov, and Martinu.

The Best of MOUG, is made available by the Music OCLC Users Group:

http://www.musicoclcusers.org/

http://www.oclc.org/oclc/cataloging/guide/index.htm
http://www.musicoclcusers.org/
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It is an excellent tool for catalogers and public service librarians because it can be kept at a desk,
card catalog, or online terminal for quick access to uniform titles for the composers that are most
difficult to search online. The authority control numbers are given so that the authority record can
be verified.

Order forms are available online at:

 http://www.musicoclcusers.org/order_form.htm

The cost is $20.00. All orders must be prepaid, with checks made out to the Music OCLC Users
Group and mailed to the address below.

 Judy Weidow
 Cataloging S5453
 The General Libraries
 The University of Texas at Austin
 P. O. Box P
 Austin, TX 78713-8916
 weidow@mail.utexas.edu
 (512) 495-4191
 FAX: (512) 495-4410

[Jay Weitz, OCLC, Bits and Pieces, Dec. 2000; edited]

Introducing OCLC PromptCat Web Statistics

OCLC PromptCat Web Statistics is a Web-based program that provides PromptCat statistics, based
on logon authorization and a date range up to one year. Logon requires an OCLC authorization and
password or vendor SAN (Standard Address Number) and password.

PromptCat Web Statistics are available to material vendors, MINITEX and other OCLC-affiliated
regional networks, service centers and international distributors, system administrators for shared
local catalogs, and individual institutions.

The statistics provided include:

•  Institution name
•  Institution symbol
•  Material vendor symbol
•  Vendor customer ID
•  Number of titles processed
•  Numbers of full records delivered
•  Percentage of records delivered/titles processed

http://www.musicoclcusers.org/order_form.htm
mailto:weidow@mail.utexas.edu
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•  Percentage of titles with matching records
•  Number of CIP records delivered
•  Percentage of CIP records delivered/total records delivered
•  Number of labels created
•  Invoice numbers sorted by delivery dates

OCLC PromptCat Web Statistics will be installed in the first week of Jan. 2001. It will be linked
from the PromptCat home page at:

http://www.oclc.org/oclc/menu/prompt.htm

[Robin Buser, OCLC, Bits and Pieces, Dec. 2000; edited]

RESOURCE SHARING

ILL Non-Referral Days for 2001 and 2002

As OCLC has become more globally oriented, we have been concerned that our ILL non-referral
holidays are too specific to the United States. Rather than add holidays for other countries, we are
going to eliminate all but a few holidays beginning with the 2002 calendar year. Starting in 2002,
the holidays we will retain are New Year's Day, Christmas Eve, Christmas Day, and New Year's
Eve. For 2001, the usual non-referral dates will be in effect.

Here is a list of the 2001 non-referral days with both the holiday and the date:

Jan. 1, 2001 New Year's Day
Jan. 15, 2001 Martin Luther King, Jr. Day
Feb. 19, 2001 President's Day
May 28, 2001 Memorial Day
July 4, 2001 Independence Day
Sept. 3, 2001 Labor Day
Oct. 8, 2001 Columbus Day
Nov. 12, 2001 Veteran's Day
Nov. 22, 2001 Thanksgiving
Nov. 23, 2001 Day after Thanksgiving
Dec. 24, 2001 Christmas Eve
Dec. 25, 2001 Christmas Day
Dec. 31, 2001 New Year's Eve

http://www.oclc.org/oclc/menu/prompt.htm
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This information, including non-referral dates for 2002, is available on the OCLC website at:

http://www.oclc.org/oclc/ill/nonreferral.htm

[Judith Carter, OCLC, Bits and Pieces, Dec. 2000; edited]

New Version of ILL ME Available in Dec. 2000

A new version of ILL ME for Windows is available for download from the Product Services Web.
ILL ME for Windows Ver. 2.1 includes some enhancements and several fixes. This new version
will also be available on the OCLC Access Suite CD, Ver. 4.0 due to be released in early 2001. A
new Getting Started Guide and Quick Reference document are also available electronically. Printed
versions will be available with the CD release.

The new version includes two enhancements and a few software fixes. The first enhancement
allows users to re-print the Shipped records and mailing labels for items they have updated to Yes
(Copies) and Yes (Loans). One or both of these options must have been selected when the update
was run. Selecting either record or labels option for the update will result in being able to re-print
either or both records and labels. The records and/or labels may be reprinted anytime prior to the
next update. To do so, go to the File menu and select either Print Yes Update Records or Print Yes
Update Labels, enter the number of copies, and click OK.

The second enhancement provides a Browse capability when assigning programs to any of the four
User Tools. To use, go to Tools menu and select Customize then Browse to the executable file for
the program you would like to launch from the tool.

 The software fixes include:

•  Up to 25 Conditional Notes names display in the Conditional Notes Manager
•  Users may download their borrowing requests with the Transaction History without long

records corrupting the database
•  Downloaded records will sort correctly on the Secondary sort field
•  Users will get an error message if they install to or create a data directory path name that

includes spaces

OCLC has decided to discontinue support of LAN installations for our software. Therefore, this
version of ILL ME does not offer a LAN install option. Users may download the installation files
to a networked directory and install to each workstation from it. The ILL ME data directory may
still be shared over a network.

Upgrading from Ver 2.0 to Ver 2.1 will retain all software settings except for the sort for printing
options. Users must reselect their Primary and Secondary sort for printing options, even if using the

http://www.oclc.org/oclc/ill/nonreferral.htm
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default values of Primary = ILL and Secondary = none. To do so, go to Tools, Options, Printing
and either re-select the options or click Reset to use the defaults.

OCLC will end support of ILL ME for Windows Ver 2.0 on April 30, 2001.

[Judith Carter, OCLC, Bits and Pieces, Dec. 2000; edited]

ILL Direct Request and NeedBefore Dates

When Patrons supply a short NeedBefore date in their FirstSearch ILL requests, the ILL record
may expire before a Lender can respond. The FirstSearch ILL workform -- rather than the Constant
Data record -- supplies the NeedBefore date in a Direct Produced ILL request if NeedBefore data is
patron provided.

There are two solutions to this situation:

•  Modify your IDR profiles to capture requests with NeedBefore dates of fewer than 7 days
and route them to your Review file. To do so, modify your existing profiles or create a new
profile named Needb4 and edit the NeedBefore profile element to read something like this:
NeedBefore date of request at earliest 7 days, but not later than 30 days.

•  Modify your FS/ILL workform to either provide a set NeedBefore date or to suppress the
display of this field. To do so, log on to the FirstSearch Admin module, go to System
Settings, ILL Request form. Use the check boxes to mark your choice of whether to make the
field required, display to the patron, or provide set data and make the field modifiable.

[Judith Carter, OCLC, Bits and Pieces, Dec. 2000; edited]

REFERENCE SERVICES

Change in Content Focus of the EventLine Database

Excerpta Medica, the producer of the EventLine database, has decided to focus the content of the
EventLine database on medical, biotechnological, and scientific event information. This change
took effect on Jan. 1, 2001.
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